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Introduction 
This is an instructional manual on how to convert different types of Microsoft Word 
documents to PDF format and make them accessible. 

A Portable Document Format (PDF) is a file format invented by Adobe that is used to reliably 
present and exchange documents, independent of factors such as software, hardware, or 
operating system. PDF is now an open standard maintained by the International 
Organization for Standardization (ISO). PDFs are able to contain various features, including 
links and buttons, form fields, audio, video, and business logic. A popular feature of a PDF is 
its ability to be signed electronically. PDFs can be easily viewed using the free Adobe Acrobat 
Reader DC software, or other PDF reader applications. 

Adobe Acrobat Pro DC is the latest subscription PDF solution offered by Adobe that allows you 
to work from anywhere with your documents. View, create, edit, and share PDF documents on 
both desktop and mobile devices. 

Adobe Acrobat Pro DC will be used throughout this manual. 

Winston-Salem State University is currently using Adobe Acrobat Pro DC version 
2019.010.20100. 

Accessibility 
A document or application is considered accessible if it meets certain technical criteria and 
can be used by people with disabilities. This includes access by people who are mobility 
impaired, blind, low vision, deaf, hard of hearing, or who have cognitive impairments. 

All users deserve the right to interact with documents to its fullest extent, without 
limitations due to barriers created by inaccessibility. Making PDFs accessible is an 
important step in preventing what could be considered a discriminatory situation for a 
business, institution, organization, or individual. The Web Content Accessibility 
Guidelines (WCAG) 2.0 (ISO/IEC 40500:2012) and the PDF/UA (ISO 14289-1) standard 
cover a wide range of recommendations for making content more accessible to people with 
disabilities. 

Accessibility features in Adobe Acrobat, Adobe Reader and in the PDF make it easier for 
people with disabilities to use PDF documents and forms, with and without the aid of assistive 
technology software and devices. These features should be used by the creators and 
distributors of PDFs in order to be fully effective. When creating PDFs, to allow users of all 
varieties access to the document, remove any barriers that may be in place. See the Making 
PDFs Accessible section of this manual for more information. 

http://www.w3.org/TR/WCAG20/
http://www.w3.org/TR/WCAG20/
https://www.iso.org/standard/58625.html
https://www.iso.org/standard/54564.html
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Microsoft Word Accessibility 
 

***All documents must be saved to a local location for the below instructions to be 
successful. (i.e. Desktop, Network Drive, etc. ) Theses instructions should work for any 
of the Microsoft Office Suite Applications.*** 

1. Open document in Microsoft Word. 
 

2. Click the “File” tab. 
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3. Select “Check Accessibility” from “Check for Issues” list. 
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4. A list of Errors and Warnings appear. (Only Errors have to be corrected at this 
time.) 
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5. Select a “Error”. The object containing the error will be highlighted. 
6. Use the scrollbar to read steps on how to correct the error. 
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Missing Alt Text Error 
 

1. Right-Click on the Image. 
2. Select “Format Object”. 

 

3. The “Format Picture” window should appear. 
4. Select the “Layout and Properties” icon . 
5. Expand the “Alt Text” Section. 
6. Updated the “Description Box” with a description of the image. (Type “Decorative” if 

the image is not displaying any information.) 
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Updating Links 

***All links should display text describing where the link will take the user to. 
NO www. Should be present in any documents.*** 

1. Copy the web address that should be present with the document.
2. Highlight the text that should be displayed for the link.
3. Right-Click the highlighted text.
4. Select “Hyperlink….” from the drop-down list. 

5. Update the “Address:” field with the web address. Click “OK”.
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6. The text should now be updated to a link. 
 

7. Update the document to text as needed to reflect the new hyperlink. 
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Table Header Error 
 

1. Highlight the header row or add a header row if it is not present and highlight it. 
2. Right-Click the header row. 
3. Select “Table Properties….” From the drop-down menu. 

 

4. Select “Row” Tab. 
5. Select the “Repeat as header row at the top of each page” checkbox. 
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PDF Conversion 
 

1. Save document. 
2. Select the “Acrobat” tab. 
3. Select “Create PDF”. 

 

4. Click “Save”. 
 

5. Now the document should open in Adobe Acrobat Pro DC. 
6. Follow the PDF Accessibility Steps to complete accessibility check. 
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Adobe Acrobat PDF Accessibility 

Gaining Access to Adobe Acrobat Pro 
(if you already have Adobe Acrobat Pro Installed you may skip this section) 

Students - Actively enrolled students receive Adobe Creative Cloud automatically 

Faculty/Staff - Download Adobe Creative Cloud using the following two steps. 

Step one - Submit a RAMTech Request for Access

1. Open a web browser and go to https://ramsupport.wssu.edu/.
2. Login with your RAM ID and password.
3. Click on Services.
4. Click on Non-Banner Enterprise Applications Support.
5. Click Desktop Applications.
6. Click Request Desktop Application Support, to begin filling out the

request form.
7. In the software name field, select Adobe Creative Cloud (Acrobat

Pro, Photoshop, InDesign, etc.)
8. Complete all of the necessary fields.

Step Two - Download the Create Cloud desktop application

1. Locate the Self Service Client on your computer using the
application list or using the search feature.

2. Install Adobe Creative Cloud.
3. Once it is finished downloading, open Creative Cloud and sign in.

4. Install Adobe Acrobat DC.

NOTE: A RAMTech service request needs to be completed to obtain

an Adobe account.

Note: Access to Adobe Creative Cloud is lost when 
users are no longer enrolled or employed at WSSU. 

https://ramsupport.wssu.edu/
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Installing Adobe Acrobat DC Pro 

1. After Adobe Creative Cloud has been downloaded to your machine open the application.
2. Type in your WSSU email address.

3. When you click in the “Password” field, the following screen should appear, select
“Enterprise ID”
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4. Login using WSSU credentials when the login window appears. 
 

5. Click on the “Apps” tab. 
6. Scroll down and click on the “Install” button beside “Acrobat DC”. 
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7. It may take several minutes for the install and may require for your machine to be restarted. 

 
 

8. The icon should now appear in your start menu. 
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Making PDFs Accessible 

The key considerations to have when creating a PDF accessible form are: 

Language: For screen readers and other assistive technologies to correctly read the 
document, there should be an overall designation of the language in which the 
document is written. Furthermore, if lines or blocks of text within the document change 
language, that text should be tagged separately. 

In MS Word, you can define the language of your document in the options menu. 
Additionally, you can change the language of individual sentences if the natural 
language for part of a document changes. In most cases, you will be able to see the 
selected document language at the bottom of the window. 

Document Information: At minimum, documents should include basic information 
like a title. It is also a good idea to provide the name of the author, a description, and a 
few relevant keywords. 

Document information like title, author, and keywords can also be added. For 
instance, in MS Word 2013 this feature is available in ‘Document properties,’ found in 
the file menu. 

Tagging Text: All text in a document should be tagged. Whether it is paragraph text, a 
heading, a list, or similar it should be labeled as such. This not only makes a visual 
distinction between various text types, but also clarifies your site for all users by 
providing the correct tagging for assistive technologies to use. 

Text that is not actively tagged by the author will automatically be tagged as paragraph 
text. If the text is a heading, make sure you select a level of heading (Heading 1, Heading 
2, etc.), rather than just changing font size, color, or format. The most efficient way to tag 
the various elements of content is by using the “Styles” feature in the “Home” menu of 
MS Word toolbar. Simply highlight text and select the style needed to tag each section 
appropriately. After structuring your content, you can then change the font types and 
colors of these headings by modifying the heading style within the “Styles” menu. 

Images: An image can have different purposes depending on how it is used in the 
document. Many images are purely decorative, which should be conveyed with 
alternative text. It is important to define such images as ‘‘artifact’, described further on. 
Other images may have some sort of function or convey important information and, 
therefore, need a different kind of description in the “alt” text. 

To make images accessible, you simply must provide the correct alternative text. In 
‘Format Picture’ there is an ‘Alt text’ tab available. Please note that in versions of MS 
Word where you have both the “title” and “description” option, to use the description. 
Unfortunately, it is not possible to define images as ‘artifact’ (decorative) in MS Word. 
To do this, you’ll have to use a remediation tool after converting the document to a PDF. 
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Tables: When data tables are used, it is important to tag their structure. At minimum 
make sure you define which the column and row headings are. Keep your table 
structure as simple as possible; try not to merge rows and columns as it complicates 
navigation for assistive technology users. 

When using tables, make sure to define table headings. In MS Word, simply label the top 
row as column headings. Then, in table properties, use the setting ‘Repeat as header 
row at the top of each page’ to tag these table headings, making them recognizable for 
screen readers and other user agents. 

Columns: If you wish to present content in columns, there is a built-in “Columns” 
feature most often available directly through the top menu. Avoid using the tab key to 
move content in a position that looks like columns. This method of creating columns 
is not only more difficult for you, but also makes the reading order very poor for 
assistive technologies. 

Reading Order: Assistive technologies rely on logical reading sequences to present 
content to users. During a document’s creation, it is extremely important to ensure 
there is a sensible reading order. 

A document’s reading order can vary depending on software version and conversion 
type. If the document originates in MS Word it will often have a logical structure. 
However, in some cases, images are prioritized last. This means if an image with 
alternative text conveys information and its position in the reading order doesn’t make 
sense, it should be moved to the correct position in the sequence. This is also possible 
through remediation tools. 

Bookmarks: For many users, the easiest and most accessible way organize a table of 
contents is to provide bookmarks based on document headings. This gives users the 
ability to navigate the PDF using bookmarked headings, rather than having to read 
through the entire document to find what they need. 

Conversion: When the document is complete and you are ready to turn it into a PDF, 
there are several options available. Depending on the method, it will create either a 
tagged PDF or a non-tagged PDF (the latter being less accessible). For instance, if you 
choose “print to PDF,” you are telling the program that the document only needs to go 
on a piece of paper and that tagging is of no importance. Therefore, tagging is not 
included, and the file size is smaller. If reducing the file size is your goal, there are other 
ways to accomplish this without removing accessibility features. To retain tags in the 
document and preserve accessibility, use the “save as PDF” or “convert to PDF” 
features. In later versions of MS Word this is readily available from the file menu. In 
older versions, there are various plugins to download for this purpose. 
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Full Accessibility Check 

Step-by-Step: 

1. Open Adobe Acrobat Pro and choose Tools. 

2. Under Customize, select Action Wizard. 

 

3. Open the file you wish to make accessible by clicking Select a File. 
 

 
 

4. After opening the file, on the right-hand side of the screen under Action List, select 
Make Accessible. 
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5. On the right-hand side of the screen the Make Accessible action panel 
should be open. Click Start to begin the process as ordered on the screen. 
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6. Fill in the fields shown in the Description dialog box. To make edits to the 
fields, uncheck Leave As Is. You must fill in the Title field, the others are 
optional. Click OK once you are done. 

 
7. The next dialog box involves modifying general settings that relates to being 

able to recognize text on the document. For most cases you can leave these 
settings as is, otherwise make the modifications that fit your needs. Click OK. 

 

 
8. Select whether or not the document is intended to be used as a fillable form. 
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9. Set the reading language for the document. Click OK. 
 
 

 
 

10. Read the notification in the next dialog box regarding images and figures, then click 
OK. 

 

 
11. The next step will identify images within the document and present you with the 

opportunity to provide the alternate text. Use the arrow buttons in the dialog 
box to go through all of the images identified. Click Save & Close when done. 
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12. The Accessibility Checker Options dialog box will appear next. This box 
allows you to select the items you want the Accessibility Checker to check for. 
In most cases you can leave the settings as is, otherwise go through the options 
and change them to meet your needs. Click Start Checking when done. 

 
13. On the left-hand side of the screen the Accessibility Checker should appear. 

Based on the options selected in the previous step, the Accessibility Checker 
will relay whether or not the document passed or failed each of the items that 
were checked. 
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14. Click the arrow beside each section to see which items passed, failed, or 
raised an issue based on the accessibility check. 

 

 
15. Right-click an item to see the available actions that can be performed in 

relation to the item. 
16. Make necessary changes to fix the items that did not pass the accessibility check. 
17. To find out more about a particular error, right-click on it and select ‘Explain.’ This will take you 

to an Adobe web page that will help to describe the error and how to fix it. 
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Reading Order 
Reading order is an extremely important part of the accessibility process. It determines 
the order in which words and other elements of the document are read by a screen 
reader. 
To fully control the reading order you’ll need two tools. 

The Order Pane 

Right-click the pane at the left-most part of the screen. Select the Order button. 

 
This shows a numbered list of the reading order along with corresponding numbered 
boxes around the content in the document. Items in the Order list can be dragged and 
dropped to correct the order. 

The Reading Order Tool 
Click the Reading Order option within the Accessibility Toolbar that should be open on the right 
side of your screen. 
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This will open the Reading Order dialog box. Important: uncheck the box that says 
“Display like elements in a single block. 
 

 

If needed, while this box is open, you can use your mouse to draw a rectangle around 
elements on the page and press the “Text/Paragraph” button (or others as appropriate) 
to either break up blocks of text that should not be read together, or to group blocks of 
text that should. 

Use the numbered list in the Order Panel to ensure screen-readers read the page 
properly. 
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Forms 
Adobe Acrobat Form Fields 
Adobe Acrobat Pro fillable PDFs are designed by adding form fields to the document in the 
desired and/or appropriate location. The form fields are accessible when Prepare Form is 
selected under Tools. The form field icons will be located on the tool bar menu.  
There are two ways to add a field to the PDF document: 

1. Click the icon of the field you wish to add from the tool bar menu OR 
2. Right click any blank space on the page and select the field type desired 

Move the mouse to the desired position on the page, then click once to add the field to the 
page.  
Edit properties of the fields by right clicking the field and selecting Properties.  
The “tooltip” field on the General tab of the field properties is the most important item for 
form fields. This property will provide the document user with information and 
instructions about the field. Tooltips should be short and descriptive and should not 
include the type of field or text such as “Click to enter”.  
Options will allow you to modify the features of the field such as style, values, item lists, 
button choices, etc. 
The following are the types of form fields that can be added to a PDF document: 

Input Type Icon Description of Input 
Text Field 

 
Enable the input and edit of text pertaining to any kind of data 

Check Boxes  Enable selection of one or more options 
Radio Buttons  Enable selction of only one option from group 
Dropdown List  Enable selection of only one item from a list that drops-down 

List Box  Enable selection of only one item from box that contains a list 
Button  Enable the initaion of an action in the document (Advanced) 
Image  Enable attachment of an image (Advanced) 

Barcode  Enable the translation of form entries into visual patterns that 
can be scanned, interpreted, and incorporated into a database 
(Advanced) 

Digital Signature  Enable the input of  e-signature that includes a digital 
certificate issued by a third-party for independent identity 
validation  

Signature Field  Enable the input of a signature from the signer 
Signature Block  

 
 

 

Enable the input of signer information including signature, 
email, title, etc using a group of specified fields (Advanced) 

Initial Field Enable the input of initials from the assigned signer 
Title Field Enable the input of the name (title) of the signers work position 

(Advanced)  
Company Field Enable the input of the name of the company that the signer is 

representing (Advanced) 
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Input Type Icon Description of Input 
Name Field  Automatically populates with the name value entered into the 

signature field (Advanced) 
Email Field  Automatically populates with the email address that the form is 

sent to (Advanced) 
Date Field  

 

 

  

Automatically populates with the date of when the form is 
accessed (Advanced) 

Auto Conversion: Word Form to Fillable PDF  
This section provides step-by-step instructions on how to automatically convert forms 
created in Microsoft Word to fillable PDF forms in Adobe Acrobat Pro.  
 
Step-by-Step: 

1. Open Adobe Acrobat Pro and choose Tools. 

 

2. Under Forms and Signatures, find and click Prepare Form. 

 
3. Click Select a file to browse for the file that is to be converted.  
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4. Once the file is selected, if the file being created will require a signature, check the 
box next to “This document requires signature.” Click Start. 

 

Note: Acrobat will automatically detect and create interactive form fields from the 
file uploaded. If Acrobat cannot detect a particular form field automatically, it can 
quickly and easily be added. 
 

5.  (Optional) Add custom form fields if Adobe Acrobat cannot automatically detect 
fields. See Form Fields section. 

6. Using the Prepare Form tool bar, select the type of form field to include on the 
document. 

 

Note: Hoover over each icon to identify the field type. 

7.  Drag the form field to the desired location on the document. After placement, the 
following basic properties should appear: 

 

8. Enter a new field name that will allow for the field to be easily identified at later 
times. 

9. Define which users are expected to sign the field.  

10. (Optional) Input the signers email and make the field required. 
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11. To edit more properties for a field, click All Properties. If the basic properties box 
has closed, right click the field and select Properties. A similar properties box will 
appear when selected for each field.  

 

Note: Some fields may have more tabs on their property box than others, but each will 
contain the main tabs of General, Appearance, Position, and Options.  

The General tab is where the main field settings are located (as shown in image 
above). Be sure to fill in the Name and Tooltip property with a label for the field 
that will adequately describe its contents. 

The Appearance tab allows you to modify features of the field box such as the border, 
color, font-size, font-color, and font-style. 
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The Position tab allows you to modify the position of the field box on the screen, as 
well as the width and height of the field box. 

 

  

 

 
 

  

The Options tab allows you to modify features of the field box the impact its function 
such as the style of a checkbox or the item list for a list box. The settings on the 
Options tab vary greatly between each field type. 

12. Click close once you finish editing the field properties. 
13. Add as many fields as needed for the document and edit their properties. 

14. Test the form by clicking Preview in the upper right corner of the Prepare Form 
toolbar and filling out each field. 

15. To return to edit mode, click the Edit button that now appears in the upper right 
corner of the toolbar. 
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16. After you finish editing, be sure to save the file by clicking the save icon in the upper 
left corner of Adobe Acrobat. 

 
 
Auto Conversion: Word Form (with media content) to PDF 
This section provides step-by-step instructions on how to automatically convert forms 
created in Microsoft Word with media content to fillable PDF forms in Adobe Acrobat. 
 
Step-by-Step: 

1. Follow the instructions in the Auto Conversion: Word Form to Fillable PDF section. 
This will cover making sure that the form is fillable. 

 
2. In the Tools tab, under Protect and Standardize, select Accessibility. 

 

 
  

3. On the right-hand side of the screen, select Set Alternate Text. 
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4. A notification will appear informing you that the images in the document are about 
to be detected. Click OK. 

 
 
 
 

5. The next step will identify images within the document and present you with the 
opportunity to provide the alternate text. Use the arrow buttons in the dialog box to 
go through all of the images identified. Click Save & Close when done. 

 

 
 
 

 
 

6. After you finish editing, be sure to save the file by clicking the save icon in the upper 
left corner of Adobe Acrobat. 

Distributing PDF Forms 
This section provides instructions on how to distribute your PDF form to the recipients 
through the Adobe Acrobat application. This feature allows you to continue the process of 
sending out documents without switching between multiple applications on your device. 
 
Step-by-Step: 

1. Once all edits are made and you are ready to distribute the form, click the 
Distribute button at the bottom of the right-hand pane. 

Note: The Adobe Sign button appears if a document requires a signature (see step 
11 of Create PDF Fillable Form or step 4 of Conversion from Word Form to PDF Form), 
otherwise the Distribute button will be displayed. 
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2. Select how you would like to distribute the form, then click Continue.  

 

 

 
 

 

3. Proceed with the steps that follow, based on your choice. 

Adobe Sign 
This section provides instructions on how to distribute your PDF form to the recipients 
through the Adobe Acrobat application using Adobe Sign. This feature allows you to 
continue the process of sending out documents that require e-signatures without switching 
between multiple applications on your device. It also provides features that allows the 
document creator to add and modify required signing fields for the recipients. 

1. Once all edits are made and you are ready to distribute the form, click the Adobe 
Sign button at the bottom of the right hand pane. 

Note: The Adobe Sign button appears if a document requires a signature (see step 
11 of Create PDF Fillable Form or step 4 of Conversion from Word Form to PDF Form), 
otherwise the Distribute button will be displayed.  

2. On the next screen, input the recipient emails and a message if desired to send 
document for signature using Adobe Sign. Click Continue. 
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Note: If there is an error with a form field, the following message will appear at the 
top of the screen: 
 

 
 

 
 
Clicking “Next Error” will take you to the error on the page, as demonstrated below. 

 
 
 

3. Review the PDF form. To add Adobe Sign form fields that are only assigned to the 
recipients, use the tool bar located on the right of the screen. Click the field you 
desire to add to the form, then drag it to the desired location on the document. 
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4. To edit certain properties of the form fields, double click the field.  

 

 

 
 

 

Note: The Assign To property allow you to decide which recipient is allowed to 
interact with that specific field. Fields marked as Required must have some content 
entered before the recipient can complete their part. 
 

5. When finished editing with Adobe Sign, click Send. 

6. The following formatted message will appear on your screen if no errors occur. 
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